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Preface

Welcome to the Trend Micro™ IM Security for Live Communications Server Getting
Sarted Guide. This book contains basic information about the tasks you need to
deploy IM Security. It isintended for novice and advanced users who want to learn
an overview of, plan, and deploy IM Security.

This Preface discusses the following topics:

e IM Security Documentation on page ii

»  About this Getting Sarted Guide on pageiii

e Audience on page iv

»  Document Conventions on page iv
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IM Security Documentation

The IM Security documentation consists of the following:

Online Help: Web-based documentation that is accessible from the IM Security
management console

The IM Security Online Help is accessible from the IM Security management
console. It contains explanations about the IM Security components and features,
which includes procedures needed to configure the product from the management
console and troubleshooting instructions.

Getting Sarted Guide (GSG): PDF documentation that is accessible from the
Trend Micro Enterprise Protection CD or can be downloaded from the Trend
Micro Update Center (http://www.trendmicro.com/download/)

This GSG containsinstructions on how to deploy IM Security, which includes 1M
Security deployment planning and testing, installation, and post-installation
instructions. See About this Getting Sarted Guide for chapters available in this
book.

Tip:

Trend Micro recommends checking the corresponding IM Security link from the
Update Center (http://www.trendmicro.com/download) for updates to
the IM Security documentation and program files.



http://www.trendmicro.com/download
http://www.trendmicro.com/download
http://www.trendmicro.com/download
http://www.trendmicro.com/download/
http://www.trendmicro.com/download
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Preface

About this Getting Started Guide

This Getting Sarted Guide discusses the following topics:

Introducing IM Security: an overview of the device and its components

Registering and Installing IM Security: recommendations and instructionsto help
you plan and deploy IM Security servers

Getting Sarted: post-installation configurations

Troubleshooting and FAQ: troubleshooting tips for issues encountered when
installing IM Security or performing post-install ation tasks

Getting Support: guidelines to obtain more information

In addition, Glossary defines IM Security related terms.
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Audience

The IM Security documentation assumes a basic knowledge of security systems,

including:

» Antivirus and content security protection

»  Genera network concepts (such as |P addressing, LAN settings)
e Live Communications Server deployment and topologies

e Live Communications Server configuration

Document Conventions

To help you locate and interpret information easily, the IM Security documentation

uses the following conventions.

CONVENTION DESCRIPTION

ALL CAPITALS Acronyms, abbreviations, and names of certain commands
and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs,
options, and service or process names

Italics References to other documentation

Monospace Examples, sample command lines, program code, Web
URLs, file names, folder names, and program output

Note: Configuration notes

Tip: Recommendations

WARNING! Reminders on actions or configurations that should be
avoided

TABLE 1. Conventions used in the IM Security documentation




Chapter 1

Introducing IM Security

This chapter introduces IM Security and provides an overview of its components and
deployment.

The topics discussed in this chapter include:

* IM Security Overview on page 1-2

*  Featureson page 1-3

e Fileand Instant Messaging Protection on page 1-10

e Protection Srategy on page 1-16

After learning the IM Security concepts in this chapter, proceed by:

»  Planning the deployment (see page 3-2)

»  Checking the IM Security deployment considerations (see page 2-4)
e Conducting apilot deployment (see page 2-5)

» Installing IM Security (see page 3-5)

1-1
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IM Security Overview

1-2

Trend Micro™ IM Security for Microsoft™ Live Communications Server represents
asignificant advancement in antivirus protection and content security for instant
messaging environments. IM Security protects your Live Communications Server
(LCS) environment from viruses, offensive content, and other instant messaging
unwanted incidents. The product is designed to provide real-time protection by
scanning both instant messages and files.

FIGURE 1-1. How IM Security works

IM Security incorporates antivirus scanning, content filtering, and file blocking into
one cohesive solution. Refer to the succeeding sections for product features,
capabilities, and deployment overview.
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Features
IM Security provides the following features:

Fast and Smple Installations

Web-based Management Console
Powerful and Creative Antivirus Features
File Blocking

Content Filtering

Updates

Alerts and Notifications

Informative Reports and Logs

Fast and Simple Installations

IM Security provides awizard-type Setup program. Setup . exe allowsyou to
easily install the product on asingle server with Live Communications Server (LCS)
2003 Home Server, LCS 2005 Standard or Enterprise (Front-End) Edition, or LCS
2005 Standard or Enterprise with Service Pack 1 (SP1).

i'é‘- Trend Micro IM Security Installation =
Welcome to Trend Micro IM Security for Microsoft Live ,’ TREND
Communications Server Setup J MICRO

Setup will install Trend Micro IM Security For Microsoft Live
Communications Server on your cormpuker,
Click Mezk ko continue or Cancel ko exit,

WARNING: This program is protected by copyright
law and international treaties.

Mext > |

FIGURE 1-2. IM Security Setup Wizard

|
InistallShield

Installing IM Security provides details on how to install IM Security.

1-3
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1-4

Web-based Management Console

IM Security provides a Web-based management consol e that allows you to configure
IM Security anytime and from anywhere on the network.

3 —‘j TREND MICRO™IM SECUT“\.'CU far Microsoft Live Communications Server -2 2% |

Current server: TITANCENTER Server Managernent

Summary (2]
Summary
b File Transfer Scan Y Your product is in grace period. atails
LGN This product will expire in 90 day(s). Letalls
» Instant Message Scan
> Uiz M update Last refresh: 3/31/2005 812823 PM YRefresh
Alerts
[¥ Component Current Available Status
» Reports Version
n Successful
b Loas [¥ Default scanning pattern 2.524.00 2.526.00 St 391/2005 2132133 AM
A=A 2 Successful
»
Administration [¥ aAdditional threats pattern 0.242,00 0.242.00 at 33172005 2:32:33 AM
¥ Scan engine 7.510.1002  7.510.1002 Gurrant

at 33172005 2132132 AM
Scan Summary for Today

Scan Type Detected % of Total Scanned

Total # of scanned files a
Uncleanable threats o 0.00%
Detected threats o 0.00%
Blocked files o 0.00%
Content violations far files o 0.00%
Total # of scanned instant messages o
Content violations of instant message o 0.00%

FIGURE 1-3. IM Security management console

The interface has the following areas:

»  Header menu: includeslinks to IM Security help file's Contents and Index,
Trend Micro Support team's Knowledge Base, and other Support tools

e Header section: displaysthe current server name and Server M anagement link
»  Navigation menu: has links to major IM Security features
»  Working area: allows you to configure IM Security options

Tip: The IM Security management console is best viewed using a screen area of 1024
X 768 pixels.
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Powerful and Creative Antivirus Features

IM Security implements the following virus, spyware, and other grayware scanning
methodol ogies:

*  Quickly scan messages and files using multi-threaded in-memory scanning

»  Scan for viruses and block files using true file type recognition

» UseTrend Micro ActiveAction (recommended) actions or customize actions
against viruses, spyware, and other grayware

2 TREND MICRO™ IM Security for Microsoft Live Communications Server LoaoF |

Current server; TW-HIE-TW2003  Server Management

Virus Scanning 2} I
Summary
~ File Transfer Scan W Enable virus scanning during file transfer
Target Action Notification

Default Scanning

Content Filtering

Select a method to scan viruses, warmns, trojans, and other ralicious codes:
¥ Instant Message Scan
@ ll scannable files

b Updates

 IntelliSean: uses "krue file type" identification
Alerts

© specfied file types ¥

» Reparts

¥ Logs Additional Threats Scanning I select all

» Administration I spyware ™ advare
™ Dialers ™ Joke Programs
™ Hacking Tools ™ Remote Access Tools
[T passward Cracking Applicstions T others @

Advanced Options

Scanning Restrictions ¥

Save | Reset

FIGURE 1-4. IM Security virus scanning

1-5
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File Blocking

You have the option to decide which files to block and what action to take against
blocked files.

0 TREND MICRO™IM Security for Microsaft Live Communications Server Log OF |

Current server; TW-HIE-TW2003  Server Mansgement

File Blocking @
Summary
- File Transfer Scan ™ Enable file blacking
virus Seanning Display + [20 per page =
File Blocking [#2dd i elete {change Priority 1-20f2 14 b H | Page |1z
| Content Fitering | Rules Gontact Action Priority Enabled
b Instant Message Scan a
g [Default file size rule] limit: |1 ke =] @ °
» Updates
™ Default file extension rle anyane Cancel ERR - ]
Alerts
} Reports [Hadd fii pelete {Ichange Priority 1-20f2 M4 H | Page |12

b Logs Save | Reset

b Administration

FIGURE 1-5. IM Security file blocking

Content Filtering

IM Security allows you to check messages and files for content deemed harassing,
offensive, or otherwise objectionable. In addition, the product provides the option to
let you specify the filter action for messages or files with unwanted content.

0 TREND MICRO™IM Security for Microsoft Live Communications Server Logoff |

Gurrent server: TW-HIE-TW2003  Server Management

Content Filtering (2]

Summary
~ File Transfer Scan [ Enable content filtering for files being transferred

Display : [20 perpage =

wirus Seanning

[“Fie Blocking | |Hadd fif Delete {]Changs Briarity 1-50f3 M 4 b M | Page: [T

[ 0MEn FILSONG et | [ Rules Contact  Action Priority Enabled
D B T e I profanity anyane  Cancel & Ashive 1 8
» Updates ™ Ragsl dizoiminstion anyane  Cancel & Ashive : @
Alerts ™ Sexusl discrimination anyone Cancel & Archive : O

: 'z:;:m [# add it Delete 4 changs Prierity P |

b Administration save | Reset

FIGURE 1-6. IM Security file content filtering

Note: IM Security is able to filter content of Microsoft Office files (* . ppt, *.doc,
* .x1s) and Adobe portable document formats (* . pdf).

1-6
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3 TREND MICROM ™M Securitu for Microsoft Live Communications Server 209 ©F |

Gurrent server: TW-HIE-TW2008  Server Management

Gontent Filtering (7]
Summary
¥ File Transfer Scan [ Enable content filtering for instant messages
~ Instant Message Scan 7 Enable trust scan

Display : |20 per page x

Content Filtering

b Updates [#/add {77 Delete £ Change Priority 1-Zof 2 M4 F M| Page: l:[
Alerts [ Rules Contsct  Action Priority Enabled
b Reparts [~ Profanity anyone Cancel & Archive 1 @
b Logs [ Radsl discrimination anyone Cancel & Archive z 9
¥ Administration 7 Sexusl diserimination anyone Cancel & Archive 2 9
[ add i Delete | change Friority 1-20f3 M 4 FH|Page: l:[

Save | Reset

FIGURE 1-7. IM Security instant message content filtering

Updates

Configure scheduled or on-demand component updates. In addition, select Trend
Micro ActiveUpdate as the update source or set other locations where new
components are available. Refer to the IM Security Online Help for details.

g TREND MICRO™ IM Security for mierasst Live Communications Server 129 OF | % TREn

Current server: TW-SMEX-SVR1 Seruer Management

Update Source [Z]
Summary
» File Transfer Scan Update Source
» Instant Message Scan @ Trand Micre's Activellpdate Server
- Updates € Intranst location containing a copy of the currant fils
Wanual une path: I
Siheduied For sxample: Wtw-serwetdovnioad
Source User name:
Alerts Passvard: I
+ Reports  Othar updats sourcs
» Logs | E=ra
* adminisraton ror sxamples gt ettt
[T Duplicats the update packags onto this serusr
save | Reset

FIGURE 1-8. IM Security Update Source

1-7
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Alerts and Notifications

Set alerts to notify administrators or selected I T personnel whenever specific IM
Security or LCS related events occur.

TREND MICRO™IM SEI:Uth for Micrasaft Live Communications Server o8 Off |

Current server: TW-HIE-TW2003  Server Management

Alerts @

Summary
» File Transfer Scan Conditions .| Recipients Message
¥ Instant Message Sean Send an alert if one of the following conditions occurs:
¥ Updates IM security services
Alerts ¥ Services started unsuccessfully
b Reports ¥ Services stopped
b Logs W component update is unsuccessful
o AR EE [” Excess session timeouts or file scanning time

Live Communications Server services

¥ Services stopped

[T Performance counter reaches high watermark

Save | Reset

FIGURE 1-9. IM Security alerts

Inform administrators and contacts about IM Security actions using customizable
notifications.

File Edit ‘iew Actions Help

& Mever qgive out your password or credit 4

card number in an instant message o [nvite Someone to
Conwersation. this Conversation
-%; Send a File or Photo
IMS_TITANCENTER@titanlcs.com says: g:‘a’t Applcation
The message matches a content =i
filtering rule, IM Security took the ) St e

"Cancel " action on
2005-01-11/18:59: 05,

Details:

LCS server:

Tw-HIE-TW2003 titanlcs.com
Sender: contactl@titanlcs.com
Recipient: contact2@titanlcs.com

@ Block A Font % ~Emoticans

Send

Last message received on 1/11/2005 at

A

FIGURE 1-10. Sample IM Security notifications via IM

1-8
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Informative Reports and Logs

Monitor IM Security activities using queried logs that detail system events, viruses,
and program update events. In addition, IM Security provides the option to send
graphical reports viaemail.

130 TREND MICRO"™ IM Security for Misosaft Live Gommunications server L239F |

Current servers TW-HIE-TW2003  Server Management

One-time Reports (7]
Surnrmary
¥ File Transfer Scan [ generate fii Delete 0-0of0 M4 ¥ H | page [L2]
3
lostantitiessansiscan [~ Report name Date From Date To Generated On Status View
» Updates
[ generate fii Delete 0-0of0 M4 ¥ H | page [L2]
Alerts
~ Reports

¥ Logs

» administration

FIGURE 1-11. IM Security reports

Proceed to the next section for details about threat and unwanted content protection.

1-9
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File and Instant Messaging Protection

IM Security protects Live Communications Server users with:
e Threat, spyware, and other grayware scanning

» Fileblocking

e Content filtering (files and instant messages)

Table 1-1 presents how IM Security appliesits file and instant messaging protections.

ORDER FILE-BASED PROTECTION IM-BASED PROTECTION
1 Virus Scanning Content Filtering
2 File Blocking
3 Content Filtering
TABLE 1-1. IM Security protection order

IM Security uses all three levels of protection to prevent files with viruses or
spyware/grayware and unwanted content from reaching intended recipients. The
product uses its content filtering protection to prevent instant messages with
unwanted content from reaching contacts.

The succeeding section explains how IM Security’s file and |M-based protection
works.

1-10
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Virus and Spyware/Grayware Scanning

When enabled, file transfer scanning continually protects your instant messaging
environment. Virus scanning scans for threats and spyware/grayware that might be
present in incoming and outgoing files.

Figure 1-12 depicts how IM Security virus, spyware, and scanning works.

LCS /IM Security
Server

a»%»@ ﬁ

® Scans for viruses, spyware, and
other grayware

* Applies action

* Sends notifications

FIGURE 1-12. How IM Security performs virus scanning

IM Security performs the following virus scanning tasks upon receiving afile:
1. Scansthefile based on configurations madein the Virus Scanning page.
2. Appliesthe virus scanning action.
Table 1-2 lists the actions that you can set.
3. Sends notifications to the administrator or contacts.
IM Security alows you to notify administrators or contacts of the virus detection
through email, IM, SNMP, or Windows Event log.
Refer to the following topics in the Online Help for details about and instructions to
configure file transfer scanning and filtering:
»  Content Filtering, File Blocking, Virus Scanning
*  Protect IM Environment(s)

1-11
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File Blocking
When enabled, file blocking scans for unwanted files based on file type, name, or
size. Figure 1-13 depicts how IM Security file blocking works.

LCS / IM Security
Server

8 - -7

* Filters file by type, name, or size
* Applies action
* Sends notifications

&

FIGURE 1-13. How IM Security performs file blocking
IM Security performs the following file blocking tasks upon receiving afile:

1. Scansand determines whether afile matchesthe criteria set for the file blocking
rules.

A file blocking rule defines how IM Security blocks afile based on file type, file
or extension name, or filesize.

3 TREND MICRO™IM Security for micrasoft Live Communications server =09 9f |
Current saruer: TW-HIE-TW2003  Sarver Managernent
File Blocking > Add (7]
Summary
« File Transfer Scan Black files accarding o the following rules,
Wirus Scanning Elock file based on:
File Blocking I Tupe
Content Filtering I Hame
»
Instant Message Scan I File size l:l IU_ m
¥ Updates
Alerts [7 Scan file types or names within zip files, This option applies to all rules,
' Reports < Back |[Hewt= | cancel |
F Logs
b Adrinistration

FIGURE 1-14. Block files by file type, name, or size

If more than one of these criteriaare enabled in asinglerule, IM Security uses an
OR relationship to connect the enabled criteria.

2. Appliesthefile blocking action.

1-12
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Table 1-2 lists the actions that you can set.
3. Sends notifications to the administrator or contacts.

IM Security allows you to notify administrators or contacts of a file blocking
event through email, IM, SNMP, or Windows Event |og.

Table 1-2 defines the Virus Scanning and File Blocking actions.

ACTION VIRUS SCANNING FILE BLOCKING
ActiveAction v x
Cancel file transfer v v
Clean v u
Deliver v v
Quarantine v x

* **
Archive u v

TABLE 1-2. Virus scanning and file blocking actions

* In addition to one of the above actions, the Archive action can be configured per rule). An LCS
Archiving Service must be available to enable querying archived messages. For more
information about Archiving Service, please refer to the LCS documentation.

** Eile Blocking saves files in the IM Security Archive directory (for example <root>: \Program
Files\Trend Micro\IM Security\Archive).

Refer to the following topics in the Online Help for details about and instructions to
configure file transfer scanning and filtering:

»  Content Filtering, File Blocking, Virus Scanning
»  Protect IM Environment(s)

1-13
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Content Filtering

When enabled, content filtering protects your instant messaging environment by
filtering all incoming and outgoing files and messages for undesirable content.

1-14

Figure 1-15 depicts how IM Security file or instant message content filtering works.

LCS / IM Security
Server

8 -2 -0 -0 -8

. Filters content

*  Applies action or delivers safe
message and sends notifications

FIGURE 1-15. How IM Security performs content filtering

IM Security performs the following content filtering tasks upon receiving a
file/message:

1.

Evaluates and determines whether a file/message being transferred contains
offensive information by comparing their content with the list of keywords taken
from enabled content filter rules.

If there arefive enabled rules, IM Security uses the keywords from those rules to
determine whether a file/message contains unwanted offensive content. The
product implements an a gorithm that consolidates all keywords from enabled
rules for filtering. Doing so allows faster file or message content filtering.

Applies the content filtering rule action.

If afile/message matches morethan onerule, IM Security appliesthefilter action
specified by the rule with the highest priority.

Table 1-3 lists the content filtering actions that you can set.
Sends notifications to the administrator or contacts.

IM Security allows you to notify administrators or contacts of the content filter
rule matching through email, IM, SNMP, or Windows Event |og.
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The following table defines the Content Filtering actions.

INSTANT MESSAGE

ACTION FiLE CONTENT FILTERING CONTENT EILTERNG
Cancel instant message v v
transfer
Deliver v v
Replace entire content x W
Replace keyword x v
Archive® v ** v kil

TABLE 1-3. Content filtering actions

* |n addition to one of the above actions, the Archive action can be configured per rule. An LCS

Archiving Service must be available to enable querying archived messages. For more

information about Archiving Service, please refer to the LCS documentation.

** Lile Content Filtering saves files in the IM Security Archive directory (for example

<root>:\Program Files\Trend Micro\IM Security\Archive).

*k%k

<root>:\Program Files\Trend Micro\IM
Security\Database\IMSecurityDB.mdf)

Refer to the following sections in the Online Help for details about:

»  Content Filtering

*  Protect IM Environment(s)

Instant Message Content Filtering saves messages in the IM Security database (for example

1-15
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Protection Strategy

An organization must design astrategy that provides optimal protection for itsinstant
messaging environment. The key decision factors for selecting an appropriate IM
Security protection strategy are:

1-16

What is the overall corporate IT security strategy?

What are the available resources (processor, memory) on available servers with
Live Communications Server?

Where and how can threats and unwanted content enter the Live
Communications Server environment (for example, file transfer, instant
message)?

Trend Micro recommends the following strategies for optimal antivirus protection for
a Live Communications Server environment:

Implementation of virus, spyware, and other grayware scanning
Creation of file blocking rules for unauthorized file types and extensions

Tip: The IM Security management console provides the recommended file types
and extensions to block.

Creation of content filtering rules for unwanted or offensive keywords present in
instant messages and files being transferred

Configuration of scheduled component update

These strategies provide very good antivirus protection, while also minimizing the
system resource usage. Refer to the Online Help for instructions on how to
implement these strategies.
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Figure 1-16 illustrates a sample environment after deploying IM Security.

Legend:

@ LCS Home servers with IM Security installed

@ Domain controller

5@ Clients

Forest 2
trendjp.net

Root domain

Forest 1
trendus.net

Child domain 2

FIGURE 1-16. A sample protected LCS environment

Proceed to the next section for details about IM Security deployment.

1-17
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Chapter 2

Testing and Performing
Pre-installation Tasks

This chapter explains how to plan and prepare for an IM Security deployment.

The topics discussed in this chapter include:

Planning for Deployment on page 2-2
Deployment Considerations on page 2-4
Conducting a Pilot Deployment on page 2-5
Redefining your Deployment Srategy on page 2-5
System Requirements on page 2-6

Pre-installation Tasks on page 2-7
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Planning for Deployment

To maximize the benefits IM Security can bring to your organization, you will need
an understanding of the possible ways to deploy IM Security to servers with Live
Communications Server installed. This section provides a deployment overview and

considerations.

Deployment Overview

PHASE 1: PLAN IM SECURITY DEPLOYMENT

Plan and identify deployment strategy
Conduct a pilot deployment
Redesign your deployment strategy

PHASE 2: INSTALL IM SECURITY

——eeepe|  Perform pre-installation tasks
Install IM Security

Verify installation

PHASE 3: MANAGE IM SECURITY SERVERS

Update components
— Configure scan and filter settings

View and analyze antivirus information
Configure server settings

2-2
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Phase 1: Plan the Deployment

During phase 1, plan how to best deploy IM Security by completing these tasks:
» Takeinto account the deployment considerations (page 2-4)
e Conduct a pilot deployment on atest segment of your network (see page 2-5)

» Redefine your deployment strategy based on the results of the pilot deployment
(see page 2-5)

Phase 2: Install IM Security
During phase 2, start implementing the plan you created in phase 1. Perform the
following tasks:
*  Perform pre-installation tasks (see page 2-7)
* Install IM Security (see page 3-5)
»  Verify successful installation (see page 4-8)

Phase 3: Manage IM Security Servers
During phase 3, manage an IM Security server from the management console.
Perform the following tasks:

e Updateto thelatest IM Security components to help guarantee current protection
for LCS servers

»  Configure scan and filter settings
e Schedule update and report generation

Note:  This Getting Sarted Guide discusses phases 1 (see page 2-4) and 2 (see page
2-7) and briefly introduces post-installation configuration tasks (see page 4-1).
Refer to the IM Security Online Help for detailed instructions relating to product
administration.
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Deployment Considerations

Consider the following when planning for an IM Security deployment:

Windows Messaging does not support L CS servers and clients behind a Network
Address Trandator (NAT)

If you are using a NAT, file transfer will not work unless you have a Universal
Plug and Play NAT (UPnP NAT). Make sure that your NAT is UPnP-compliant.

In an LCS Home Server setup, you need to install IM Security on each Home
server to enable virus scanning and content filtering for your entire organization

Setup does not detect the presence of LCS Archiving Service in atarget
environment

To make use of the Archive action in File Blocking and Content Filtering, as
well asthe View Details link available in L ogs > Query > Content filtering for
IM results, an LCS Archiving Service must be present and properly configured
in your environment. An LCS Archiving Serviceis an optiona component in an
IM Security deployment. Refer to Microsoft LCS documentation for more
information about the L CS Archiving Service.

If afirewall exists between an LCS server and its clients, ensure IM Security
ports are opened (see page 2-7)

If you have multiple Activation Codes, you must install IM Security to servers
separately (that is, simultaneous and remote installation is not possible)

The Setup program provides you with the option to enable Secure Sockets Layer
(SSL) management console connection

Use SSL to help ensure secure communications between your Web browser and
the IM Security server.

Note:  You cannot configure SSL from the management console. SSL must be
enabled during installation.

Setup does not require stopping the LCS services

Remove other instant messaging antivirus applications before installing IM
Security. Otherwise, a scanning conflict may occur

Setup does not detect other instant messaging antivirus applications.

Remember to exclude the IM Security folders from other server-based antivirus
application’s scanning (see Preparing Other Antivirus Applications)
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Conducting a Pilot Deployment

Trend Micro recommends conducting a pilot deployment in acontrolled environment
to help you understand how features work, determine how IM Security can help your
organization accomplish its security goals, and estimate the level of support you will
likely need after afull deployment. A pilot deployment allowsyou to validate and, if
necessary, redesign your deployment plan.

Perform the following tasks to conduct a pilot deployment:
e Chooseapilot site

» Create acontingency plan

»  Deploy and evauate your pilot

Choosing a Pilot Site

Choose a pilot site that matches your planned deployment. This includes other
antivirus installations (such as Trend Micro™ OfficeScan™, ScanMail ™, and
ServerProtect™) you plan to use. Try to simulate the type of topology that would
serve as an adequate representation of your production environment.

Creating a Contingency Plan

Trend Micro recommends creating a contingency plan in case there are issues with
the installation, operation, or upgrade of IM Security services or components.
Consider your network’s vulnerabilities and how you can retain a minimum level of
security if issues arise.

Deploying and Evaluating your Pilot

Deploy and evaluate the pilot based on expectations regarding both security
enforcement and network performance. Create a list of items that meet and do not
meet the expected results experienced through the pilot process.

Redefining your Deployment Strategy

Identify the potential pitfalls and plan accordingly for a successful deployment,
especially considering how IM Security performed with the antivirusinstallations on
your network. This pilot evaluation can be rolled into the overall production and
deployment plan.
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System Requirements

Individual company networks are as unique as the companies themselves. Therefore,
different networks have different requirements depending on the level of network
complexity. This section describes both the minimum and recommended
requirements for an IM Security server.

Tip: Use these values to obtain an idea on how to allocate server resources that can
support the users' needs in your organization.

The following table lists the system requirements for IM Security.

HARDWARE/SOFTWARE

SR ECATIONS MINIMUM REQUIREMENTS

CPU Intel Pentium™ 550MHz or faster processor
Hard disk space 200MB of available disk space
(program and database folders)
Memory 512MB
Windows Server™ 2003 Standard or
Enterprise edition
Microsoft™ Live 2003 Home Server,
Communications Server 2005 Standard or Enterprise (Front-End) Server, or

2005 Standard or Enterprise Server with Service Pack 1

Note: The LCS Archiving Service is an optional
component in an IM Security deployment. If you
want to archive instant messages traffic to and
from your IM environment, install this
component. You can then use the IM Security
management console’'s Logs > Query option to
search for and view archived messages.

Web server Microsoft Internet Information Services 6.0 or
Apache Web server 2.0
Web browser Internet Explorer™ 5.5 or Netscape™ Navigator 7.2
Java Virtual Machine (JVM) Microsoft JVM or Sun JVM version 1.4.1_02
Note: For more information about Microsoft JVM,
please visit
http://www.microsoft.com/mscorp/javal.
Messaging clients Windows Messenger 5.0 or 5.1
TABLE 2-1. IM Security minimum system requirements
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Recommended System Requirements
In addition to the minimum system reguirements, consider the following system
requirements to obtain optimum IM Security performance:
»  Scale the memory with the processor; do not overpopul ate with memory

» UseaVGA monitor capable of 1024 x 768 resolution, with at least 256 colors
whenever accessing the IM Security management console (page 4-10)

Pre-installation Tasks

Several pre-installation tasks can help to make the installation process easier.
Compl ete the following tasks before installing IM Security (see page B-4 for the
checklist version):

» If afirewall exists between an LCS server and its clients, open the ports
described in Table 2-2 to ensure IM Security connectivity

SERVICES PoRTS NEEDED

Management console HTTP: 80
HTTPS: 443

File transfer 6891-6900

Notification SMTP: 25
SNMP: 162

Server Management population 3268

through Global Catalog (GC) query

TABLE 2-2. Ports for IM Security connectivity
» Log on tothetarget server using an account with Domain Admins privilege

Setup requires a user with Domain Admins privilege to create the IM Security
accounts (page 4-2).

» Disableor uninstall other IM environment antivirus applications

The IM Security Setup program does not detect third-party IM environment
antivirus applications. Disable or uninstall third-party antivirus applications to
prevent scanning conflicts.

e Check the target server complies with the system requirements

If the server’s specifications do not meet the requirements (see page 2-6), Setup
will not install IM Security.
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»  Obtain the proxy server and SMTP server settings and authenti cation information
(if necessary)
During installation, the setup program prompts you to enter proxy information. If
aproxy server handles Internet traffic on your network, you must type the proxy
server information, your user name, and your password to receive pattern file and
scan engine updates. If you leave the proxy information blank during installation,
you can configure it at a later time from the management console.

»  Close opened Microsoft Management Console (MMC) screens

*  Preparethe IM Security Activation Code (see page 3-2)

After completing the pre-installation tasks, proceed by registering (see page 3-2) or
installing IM Security (see page 3-5).
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Chapter 3

Registering and Installing IM Security

This chapter introduces IM Security and provides an overview of its components and
deployment.

The topics discussed in this chapter include:

Registering and Obtaining an Activation Code on page 3-2
Installing IM Security on page 3-5

Activating IM Security on page 3-24

Removing IM Security on page 3-25
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Registering and Obtaining an Activation Code

Use your Registration Key to register your product on the Trend Micro Online
Registration Web site. Register your products to ensure eligibility to receivethe latest
security updates and other product and maintenance services. After completing the
registration, Trend Micro sends an email message that includes an IM Security
Activation Code, which you can then use to activate IM Security.

IM Security has two types of Activation Code:

e Evaluation AC

An Evaluation AC allows you to implement IM Security’s full functionalities for
alimited evaluation period. During the evaluation period, IM Security performs
virus scanning, file blocking, and content filtering, as well as component update.

e Standard AC

A Standard AC allows you to implement IM Security’s full functionalities.

Tip: For information on purchasing a standard version Registration Key from a

reseller, see Trend Micro Sales Web page.

Table 3-1 defines how IM Security behaves depending on the Activation Code

activation and expiration.

STANDARD VERSION EVALUATION VERSION
FEATURE ACTIVATED EXPIRED ACTIVATED EXPIRED

File/IM scanning and filtering H H ﬂ n
ActiveUpdate

(when the (when the

# of seats ) # of seats )

is not is not

exhausted) exhausted)
Management console access H H H H

TABLE 3-1.

3-2
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The management console displays the remaining number of days before an
evaluation or full version AC expires. Trend Micro recommends registering and
obtaining a full version AC before the expiry date to allow uninterrupted LCS
environment protection.

Tip: You may register IM Security during installation (see page 3-16).

To register IM Security and obtain an Activation Code:

Note:  These Web screens and workflows are subject to change without prior notice.

1. Using aWeb browser, go to Trend Micro Online Registration
(http://olr.trendmicro.com). The Online Registration page of the
Trend Micro Web site opens.

[Global sites =l [search O]
a TREND, DR F EE HELE
J M1CRO
Home = Products | Purchase JECHITLISS Security Info © Partners | About Us : Find a product ~
Knowledge Base Harme = Support = Online Registration
FAQs
Update Genter Online Registration
Supparted Versions
welcome to the Online Registration site for Enterprise and Small/Medium Business (SMB) Custorners.,
Bets Programs
Wirus Response Service Harme users should search the Trend Micro Knowledge Base for instructions to register PC-cillin Internet
Security or Gatelacl
Submission Wizard
Prermiurn Support Sign in: First visit, or
Evaluation version customer:
Online Registration
> Help
- 1need to activate purchased software
Logon ID:
9 - I need to sotivats svaluation softwars
Password:
United Statez-English =
Login
Continue
Instructions:
= Purchasing the software
Note: As part of the registration process, Trend Micro will collect certain contact information, which may
include personal data, for business reasons. Trend Micro agrees not to share this information generally
with third parties ather than as required to directly provide you with the services for which yau or your
company or organization have paid. For details about our information collection and use practices,
please review aur Privacy Policy.
Legal Motice | Privacy Policy | Contact Us _I

FIGURE 3-1. Trend Micro Online Registration
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2. Perform one of the following:

» If you already have an account with the Online Registration Web site, log on
using your logon 1D and password

e Otherwise, if you are a new customer, select your location and click
Continueunder First Visit...

3. Onthe Enter Registration Key page, type or copy the IM Security
Registration Key, and then click Continue.

4. Onthe License Agreement page, read the license agreement and then click |
accept.

5. Onthe Confirm Product Information page, click Continue Registration.

6. Fill out the online registration form, and then click Submit.

7. Click OK twice.

After completing the registration, Trend Micro sends an Activation Code via email,

which you can then use to activate IM Security. Perform one the following methods
to activate IM Security:

e During installation (see page 3-16)
» After installation via the management console (see page 3-24)
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Installing IM Security

This section provides details about IM Security installation. Ensure that you have
performed the Pre-installation Tasks before running Setup.

To install IM Security:

1.

o bk~ wDd

Wait while Setup installs RTC Client APl 2.1 and MSDE 2000 IM Security
instance (see page 3-5).

Note:  Skip this step if you are upgrading from a previous IM Security build or if you
have not removed these programs from a previous IM Security installation.

Set the product and database installation folder (see page 3-9).

Configure the Web server and proxy server settings (see page 3-12).

Activate the product and set World Virus Tracking participation (see page 3-16).
Set administrator and notification accounts (see page 3-18).

Step 1: Wait while Setup installs RTC Client APl 2.1 and MSDE 2000 IM Security

1.

instance.

Do one of the following to navigate to the Setup program (Setup . exe):

» If youareinstalling from the Trend Micro Enterprise Protection CD, go to
the IM Security folder on the CD

View product I nformation, System Requirements, or complete IM
Security Documentation in the corresponding view pane.

* If you downloaded the software from the Trend Micro Update Center,
navigate to the relevant folder on your server

Double-click Ssetup . exe to launch the wizard installation program.
The Setup Prompt screen appears.
seten B

-
y ‘Would you like ko install Trend Micro IM Security For Microsoft Live Communications Server?

FIGURE 3-2. Setup Prompt screen
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3. Click Yesto start.
Setup performs one of the following tasks:

If you areinstalling IM Security for the first time, Setup initially installs
RTC Client API 1.2 and Microsoft SQL Server Desktop Engine (M SDE)
2000 instance before displaying the Welcome screen

RTC Client API ¥1.2

Cancel

FIGURE 3-3. Installing RTC Client API 1.2 MSDE 2000 instance
IM Security uses RTC Client API to send IM-based notifications.

Microsoft SOL Server Desktop Engine

AL| Pleaze wait while Windows configures Microsoft SOL Server
“\:-‘ Desktop Engine

Time remaining: 21 seconds

([ []] Cancel |

FIGURE 3-4. Installing MSDE 2000 instance
IM Security uses MSDE to store logs to the IM Security database.
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If you haveinstalled IM Security before and have not removed RTC API 1.2
and M SDE 2000, Setup proceedsto the IM Security installation and displays

the Welcome screen

i'-‘%' Trend Micro IM Security Installation LI

Welcome to Trend Micro IM Security for Microsoft Live 0 TREND
Communications Server Setup J MICR

o

Setup will install Trend Micra IM Security For Microsaft Live
Communications Server on your cormputer,
Click Mext bo continue or Cancel bo exit.

‘WARMING: This program is protected by copyright
law and international treaties.

Mext = |

FIGURE 3-5. Welcome screen
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4. Click Next >. The License Agreement screen appears.
]
License Agreement
@) TREnD

Please read the Following license agreement carefully,

MOTICE: Trend Micro licenses its products in accordance with certain terms and ﬂ
conditions. By breaking the seal on the CD jacket in the Software package or

installing a serial mumber, registration key or activation code, You already accepted a
Trend Micto license agreement. A courtesy copy of a representative Trend Micro
License Agreement iz included for reference below. The language and terms of the
actual Trend Micro license agreement that you accepted may vary. By clicking "I

A ccept” below or using the Software, Vou confirm Your agreement to the terms and
conditions of the original Trend Micro licenise agreement you accepted.

Trend Micro License A greement
(Felease Build Version 0403M ow03D021004) j

' 1 arcept the terms in the license agreement

" 1dn not accept the berms in the license agreement

Installshisld

< Back MNexk = Cancel

FIGURE 3-6. License Agreement screen
Select | accept thetermsin thelicense agreement to continue with the

installation. Otherwise, select | do not accept thetermsin thelicense
agreement; the installation will end, and Setup will close.
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Step 2: Set the product and database installation folder.

1. Click Next >. The Installation Folder screen appears.

Specify the compl ete path and folder name where you want to install IM
Security. Accept or modify the default destination folder (¢ : \Program

Files\Trend Micro\IM Security).

Installation Folder
(D) TREN
MICR

Specify the IM Security pragram installation Falder.

x|
D

Setup will install Trend Micra IM Security in the Folder specified belaw,
Click Browse to specify another Folder in the local directory.,

Destination Folder

C:\Program Filesi Trend MicroiIM Security!, Browse... |

Inistallshield

Cancel

FIGURE 3-7. Installation Folder screen
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2. Click Next >. The Database I nstallation Folder screen appears.

i'é‘- Trend Micro IM Security Installation ll

Database Installation Folder
) TREND.
Select the IM Security database installation path, MICRO

Setup will install the IM Security database in the Folder specified below,
Click Browse ko specify another Folder in the local directory,

Trend Micro recommends specifying a location that will help optimize database access
and performance,

Destination Folder

C:\Program Files! Trend MicrolIM SecurityiDatabase!

InistallShield

< Back | Mext = | Cancel

FIGURE 3-8. Database Installation Folder screen

Specify the full path where you want to install the IM Security database
(IMSSecurityDB.mdf) and database log file (IMSecurityDB.1df).
Accept or modify the default installation folder (¢ : \Program
Files\Trend Micro\IM Security\Database).

Tip: Trend Micro recommends specifying a location that is the same as the IM
Security program folder. In addition, do not move the database and database
log file from its installation path to avoid connectivity issues.

3-10



Registering and Installing IM Security

3. Click Next >. The System I nfor mation screen appears.
]
D.
o

System Information

(D), TREN
Refer to the Getting Started Guide or Readme. bxt For system requirements MICR
information.

Setup detected the Following system information:

[Operating Systemn] -
Microsaoft Windows Server 2003 family, Enterprize Edition
[Memany]

512 MB

[eh Server]
Internet Infarmation Services {I1S) Version 6.0
Apache HTTP Server 2.0.52

[Live Communications Server]
Microsoft Live Communications Sener 2005 x|

InistallShield

< Back Cancel |

FIGURE 3-9. System Information screen

Setup checks the local server for compliancy with the system requirements and
displays the server’s specification.
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Step 3: Configure the Web, Simple Mail Transfer Protocol (SMTP), and proxy
server settings.

1. Click Next >. The Web Server screen appears.
]
Web Server
@) ren

Select the Web server bype,

Select from the list below ko specify the bype of Web server available on the LCS
server, IM Security will use the Web server you selected ko publish its management
console.

& Microsoft Internet Information Services 6.0

= Apache Web server 2,0

Inistallshield

< Back Cancel

FIGURE 3-10. Web Server screen

Select the Web server installed on the target server: Microsoft 1S or Apache
Web server. IM Security will use this server to publish its management console.

Tip: Before running Setup, install a Web server application on the target server.
See Pre-installation Tasks for additional tasks that you should perform
before installing IM Security.
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2. Click Next >. The Web Server Settings screen appears.

i'-‘%' Trend Micro IM Security Installation

Web Server Settings
Specify the Web server settings.,

X
D.

() TREN

115 web site: IDeFauIt web site

Part number: ISD

Secure Sockets Layer

¥ Enable S5L

Certificate validity: |3 yearis)
5L part: Ja43
InistallShield

< Back

Cancel

FIGURE 3-11. IS Web Server Settings screen

i'-‘%' Trend Micro IM Security Installation

Web Server Settings
Specify the Web server settings.,

Part number: ISD

Secure Sockets Layer

[™ | Enable 550
Certificate validity: |3 yearis)
5L part: Ja43

InistallShield

< Back

Cancel

FIGURE 3-12. Apache Web Server Settings screen
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Set the Web server port and encrypted connection configuration. M Security will
use these settings to encrypt communication between the management console to
the IM Security server.

a. Ifyousdected I1SWeb server (Figure 3-11), select the site that will host
the management console Web pages. This option is not available when
Apache Web server is selected.

b. Accept or type anew port number that Setup will use for management
consol e access (only appliesto 11S).

If you changed the HT TP port to another value other than the default
number (80), including the port number in the URL is necessary.

¢. Under Secure Sockets L ayer, select Enable SSL to enable secure
communication between your Web browser and the IM Security server.

Tip: Enabling SSL is only available during installation. Trend Micro
recommends this option to help ensure secure communication.

d. Typethecertificate validity and if necessary, modify the allocated SSL
port.
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3. Click Next >. The Proxy Server Settings screen appears.

i'é" Trend Micro IM Security Installation 5'

Proxy Server Settings
D) TREND.
MICRO

Specify proxy server settings.

Installshield

1M Security uses the Following settings during product activation and component download,

—Settings

I Use a proxy server For component download and product activation

Address: I Port:

[T Use s0CKSS

Authentication {optional)

User nare: |

Password: |

Cancel

FIGURE 3-13. Proxy Server Settings screen

If you use aproxy server to connect to the Internet, select Use a proxy server for
component download and product activation, and then set the following:

Proxy server: type the FQDN, |P address, or NetBIOS name of the server
Port: type the proxy port number

Use SOCK S5: select this option if the proxy server is using SOCK S5
protocol

User name: type alogon name that can access the proxy server

Provide both the domain and logon names, for example:
mydomain\admin.

Passwor d: type the password for the user name
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Step 4: Activate the product and World Virus Tracking program participation.

1. Click Next >. The Product Activation screen appears.

i'é" Trend Micro IM Security Installation ﬂ
Product Activation
. . . . . P, TREND.
Activate Trend Micro IM Security to enable scanning and security MICRO
updates,

Setup requires a valid IM Security Activation Code bo enable scanning and security updates.

Click Register Online to register the product online using the supplied
Reqistration Key. An Activation Code will be provided once you have
successfully registered the product.

Type the Ackivation Code:

[ | | |

Installshield

< Back Mext = Cancel

FIGURE 3-14. Product Activation screen

If you have not obtained an IM Security Activation Code, click Register Online
and follow the Online Registration promptsto obtain an Activation Code (see
instructions available on page 3-2). Otherwise, type or paste the acquired
Activation Code in the fields provided.

Tip: You may skip this step and activate IM Security using the management
console > Administration > Product License page at alater time (see page
3-24).
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2. Click Next >. The World Virus Tracking screen appears.

i'é‘- Trend Micro IM Security Installation ll

World Yirus Trackin
N ) TREND
Participate in the Wworld Wirus Tracking Program, MICRO

Trend Micra consolidates virus-scanning results From worldwide customers, compiles real-time
statistics, and displays them on the Yirus Map., Use this map to view virus trends for each
continent and selected countries:

£+ Yes, Twould like o join the World Yirus Tracking Prograrm.

I understand that when a virus is detected on my system, aggregated detection
information, including virus names and number of detections, will be sent to the World
Yirus Tracking Program. It will not send out company names, individual names, maching
names, site names, IP addresses, or any other identifying information. I understand
that I can disable this automatic reporting Function at any time by changing the
configuration to "Mo" within the product's management. console,

Mo, I don't want to participate.

Inistallshield

Cancel

< Back

FIGURE 3-15. World Virus Tracking screen
Select Yes, | would liketo join the World Virus Tracking Program. If you

wish to join this program at a later time, use the management consol€’s
Administration > World Virus Tracking option to participate.
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Step 5: Set IM Security administrator account(s).
1. Click Next >. The Administrator Account screen appears.
x
D,

Administrator Account
(D) TREN
mMICcR

Specify the IM Security administrator account,

Create a new or specify an existing Active Direckory account that wou will use to administer
1M Security through its management console, Setup will create the IM Security Admins group
and include this account ka the group.

To specify additional IM Security adrinistratars at a later time, add users in IM Security
Admins using the Active Directary MMC snap-in,

" Create a new account

i Specify an existing account from Active Direckory

User name: I

Password: I

InstallShield

Cancel

< Back

FIGURE 3-16. Administrator Account screen

Create the administrator account or specify an existing Active Directory user that

Setup will designate as the IM Security administrator:

» If you are creating a new account, specify auser name that is easy to
remember and descriptive of IM Security management duties (for example,
ims_admin)

Inaddition, provide a strong password to help secure product administration.

Note:  Setup displays a message if the password provided does not meet the
required complexity and length.

» If you are specifying an existing account, Setup adds the account to the IM
Security Adminsgroup
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2. Click Next >. The IM Notification Account screen appears.

IM Notification Account

i'é‘- Trend Micro IM Security Installation ll
D.
o

Specify an account that IM Security will use to send IM-based @ IE EE
natifications.

InistallShield

In addition, IM Security uses this account to connect to, view status, or replicate settings of
reqgistered servers available from the management console's Server Management list,

Refrain from deleting or modifying this account, Otherwise, IM Security might experience issues
when sending IM-based notifications or administering other registered servers,

SIP address: I

User name: I

Password: I

Confirm password: I

Specify the communications service setting,

Connect using: * TCP TS

< Back I Mext = I Cancel

FIGURE 3-17. IM Notification Account screen

a.

o o

Create an account or specify an existing Active Directory user that IM

Security will use to send IM-based notifications.

» If you are creating anew account, accept the predefined SIP address and

user name

Otherwise, specify a SIP address and user name that are easy to
remember and descriptive of IM Security notification duties (for

example, ims_notification agent)

» If you are specifying an existing account (user name or SI P address),

Setup displays an error and requires you to specify anew or unique

Active Directory user

Specify a strong password to help secure product administration.
Select the communication service setting that IM Security will use

whenever it sends | M -based notifications.
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Tip: Transmission Control Protocol (TCP) sends instant messages in plain
text. Alternatively, Transport Layer Security (TLS) sends encrypted
instant messages.

Setup creates the IM Security Admins Active Directory group, and then adds
the administrator and notification accounts to the group.

3. Click Next >. The Email Notification Settings screen appears.
x|

Email Notification Settings {Optional)
) TREND.
Specify the SMTP server settings, MICRO

1M Security will use the Following SMTP server settings when sending email-based
notifications, You may use the IM Security management console to specify SMTP server
settings and configure email-based notifications after installation,

SMTF server: I

For example: 112,223,222.111 or smtpsry,domain, com

Part number: |25

InistallShield

Cancel

< Back

FIGURE 3-18. Email Notification Settings screen

Configure the SM TP server and port number that IM Security will useto send
notifications and alerts viaemail. If you want to set the SMTP server at alater
time, use the IM Security management console’s Administration > Notification
Settings page.
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4. Click Next >. The Ready to Install screen appears.

Ready to Install
eady to Instal aTREN
JHIUR

The wizard is ready to begin installation,

X
D

Click Install to begin the installation.

IF wou want to review or change any of your installation settings, click Back, Click Cancel to
exit the wizard,

InistallShield

Cancel

< Back

FIGURE 3-19. Ready to Install screen

Click Back to modify specific installation settings.
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5. Click Next >. Setup installs IM Security files, services, and other componentsto
the target server.
i'é‘- Trend Micro IM Security Installation S i

Installation

The program features you selected are being installed,

Flease wait while the InstallShield Wizard installs Trend Micro IM Security,
This may take several minutes.

Status:

Updating component regiskration

[ ]

Installshield

= Back Idext =

FIGURE 3-20. Installation screen
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6. Click Finish. The Installation Completed screen allows you to view the product
ReadMe or manually update its antivirus and content security components.

fa= Trend Micro IM Security Installation

Installation Completed 0 TREND.
J ICRO

The Installshield Wizard has successfully installed Trend Micra IM Security, Click Finish to

¥ Wiew the readme File

Cance

= Back

FIGURE 3-21.

Installation Completed screen

See Verifying a Successful Installation to confirm whether IM Security has been
successfully installed.

Trend Micro recommends performing the post-installation procedures to establish a
security baseline for your Live Communications Server environment. See Getting
Sarted for instructions.

See Installation for help when issues occur during IM Security installation.

3-23



Trend Micro™ IM Security Getting Started Guide

Activating IM Security

3-24

Activate IM Security to keep your antivirus and content security components current.

To activate your product, register online and obtain an Activation Code using your

Registration Key.

» If you have purchased the standard version AC from a Trend Micro resdller, the
Registration Key isincluded in the product package

Register online and obtain an Activation Code to activate the product.
e Otherwise, if you are using an evaluation version

The evaluation version is fully functional for 30 days, after which IM Security
taskswill continue to load, but no virus scanning, message filtering, nor
component update will occur.

Obtain a standard Registration Key from your reseller and then follow the
instructions to activate the product.

After you have obtained an Activation Code either from your product package or
purchased through a Trend Micro reseller, activate IM Security to use al of its
functions, including downloading updated program components.

Tip: Setup provides an option to activate IM Security during installation (see page
3-16).

To activate IM Security using the management console:
1. AccessthelM Security management console (see page 4-10).

2. Ontheleft-hand menu, click Administration > Product License. The Product
L icense page appears.

3. Click Enter a New Code, and then type the full version AC in New Activation
Code.

4. Click Activate.
IM Security is now activated. Standard maintenance support is included in the initial

purchase of IM Security license and consists of one year of component updates,
product version upgrades, and telephone and online technical support.
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Removing IM Security
Uninstallation removes the following IM Security components (refer to page 4-2 for
details):
*  Web server entries
* All program files and folders
e WMI entries
» Active Directory objects
»  Performance Counter objects

Note:  Removal will automatically remove RTC Client APl 1.2 and MSDE 2000 IM
Security instance. Do not remove these components before uninstalling I|M
Security.

To uninstall IM Security:

1. GotoSart > Control Panel > Add/Remove Programs.

2. Select Trend MicroIM Security for Microsoft Live Communications Server,
and then click Remove.

3. At the prompt, select Yesto remove IM Security.
LI
Currently installed programms: Sort by: Im

ﬁ! Microsoft SGL Server Deskhop Engine (IMSECURITY) Size  B9.7EMB =

] Al ot Ao s raviaiia:
Add or Remove Program: x|

? ) Are you sure you want to remave Trend Micro IM Security For Microsoft Live Communications Server from your computer?

i5) Trend Micro IM Security for Microsoft Live Communications Server Size  B5.76MB
Click here for support infarmation. Used rarely

Ta remave this program From your computer, click Remove,

(Remove
L] ¥Mware Workstation Size  47.51ME
3 Windows Messenger 5.1 Size 4,088.00MB B
5 winFast(R) Display Driver Size z.16MB

FIGURE 3-22. Removing IM Security

IM Security is removed from the server.
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Chapter 4

Getting Started

Trend Micro recommends performing specific tasks after installing and activating IM
Security.

The topics discussed in this chapter include:

System Changes on page 4-2

Preparing Other Antivirus Applications on page 4-8

Verifying a Successful Installation on page 4-8

Accessing the IM Security Management Console on page 4-10
Checking Default Settings on page 4-13

Updating Components on page 4-15
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System Changes

The following server changes occur after running a successful IM Security

installation:

Note:  These changes are thoroughly described in the succeeding sections.

COMPONENT

DETAILS

Product and SQL agent
services

Setup adds four services

FIGURE 4-2. Processes

Mame / | Stakus
8 M3SOLEIMSECURITY Started
8 50LAgent S IMSECLURITY Started
%Trend Micra IM Security Server Starked
%Trend Micro IM Security Syskem Attendant Skarted

FIGURE 4-1. Services

Task Manager processes | Setup adds two processes:
L=IEY
File Cptions Wiew Help
Applications ~ Pracesses IPeanrmance I Netwnrkingl Users I
Image Name | User Mame | CPUl Mem Usagel ;l
ritfrs.exe SYSTEM an Te0K
Radmin, exe Adminiskratar oz 10,720k
rundllzZ. exe Administratar an 1,668 K
Services.exe SYSTEM oo 14,592 K
servIM3IHost exe SYSTEM oo 40,720 K
servIM3SA. exe SYSTEM oo 15,656 K
SMS5.EXE SYSTEM an 236K |

Active Directory objects

Setup adds two (2) users and one (1) group based on what you
configure during installation (see page 3-5):

arme | Type

ﬂ IM5admin User

ﬂ IMSnotification User

ﬁIM Security Admins Security Group - Global

FIGURE 4-3. Active Directory objects

TABLE 4-1. System changes after installing IM Security
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COMPONENT DETAILS
IIS Web site Depending on the Web Server Type screen, Setup follows
your Web server settings (see page 3-13):
Note: If you have
Apache installed F_J Inkernet Information Services TWarne
. ! -5 0 Tw-HIE-T'W2003 (local computer) J ActiveUpdate
see Figure 4-5. : - i
__J Appbhcatmn Pools ) applet
[=-__ Web Sites L
- ! __l cgi-bin
E|-- Defil:ultt'v(\:-'ebtﬂtle 23 css
-
4 CertCanktrol I help
g CertEnrall b
: —‘f'; CertSry "‘J_ m
ERY 115 curity -/ images.
[ Activelpdate ) javascripts
_J report
_dxml
| DialogLayout. class
| dr_imageltem,class
| Encrypt.class
| help_start.hkm
| JavaMDS. class
| Login kit
‘ ) | MDSSkate, class
-l Web Service Extensions | MessageBox. class
| MultiLineLabel class
|
FIGURE 4-4. IIS changes
TABLE 4-1. System changes after installing IM Security
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COMPONENT

DETAILS

Apache Web site
Note: If you have IS

installed, see
Figure 4-4.

Setup follows your Web server settings (see page 3-13)

& httpd.conf - Notepad -[af x|

File Edit Format Help

# IM Security virtual path —- Start

scripralias JImsecurity/cgi-bing "c:/Program Files/Trend micro/Im
securitywebscgi-bins”
<pirectory "C:/Program Files/Trend Micro/IM Security/web/cgi-bin">
Towowerride Hone
options_ None
order allow,deny
Allow from all
</Directory:

#$reportPath
alias JImsecurity "C:/program Files/Trend micro/Im security/webs"

<Directory "C:/Program Files/Trend Micro/IM Securitysweh/"'>
options None
Allowoverride None
order allow,deny
Allow from all
</Diractorys

# IM Security virtual path -- End
# IM Security wirtual pPath -- start

scriptalias JImsecurity/cgi-bing "Ci/Program Files/Trend micro/Im
Security/web/cgi-bing”
<pirectory "C:/Program Files/Trend micro/IM Security/web/cgi-bin">
Allowoverride Mone
options_None
order allow, deny
Allow from all
</Directorys

FIGURE 4-5. Apache changes

]|

Performance Counter
objects

Setup adds Performance Counter objects, which you can then

select to view IM Security performance.

—oix|
i He Acton Yow Favaies windon o =lslx|
o @@

O ol Qlft ol [@aal +x[e| sleE of=e)

=4 100

&
a0
@
%
7

Lt 27 average | 27 Miium [ 27 Maum 27 ourstion | 140
Csck [ Comtar Instance | Parent_| Object | Computer

= it
110,102,115

w 10.10.2.115
... 110,102,115

FIGURE 4-6. Sample Performance Counter view

TABLE 4-1. System changes after installing IM Security
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COMPONENT DETAILS
LCS Properties update Setup updates the LCS > Applications > Properties and adds
an IM Security-related entry.
Applications Properties
Applications |

Awailable applications:

Application UR ove Lp

Yes hittp: /A trendmicra. com/disle/D efaull... Move Down
Add..
Edit
Remave

i~ Details
Name: Routing Application Setting - Default
LRI http: v, microsolt. comLCS /D ef aultRouting
[V Enabled —
cript onily|
¥ Ciitical

oK I Cancel | Apply | Help

FIGURE 4-7. LCS changes

Add/Remove Programs Setup creates three Add/Remove Programs items: Trend
items Micro IM Security for Microsoft Live Communications
Server, RTC Client API v1.2, and Microsoft SQL Server
Desktop Engine (IMSECURITY).

8 Add or Remove Programs =] B3

Currently installed programs: ™ Show updates sortby: wame 7]
2 Microsoft Office Live Commurications Server 2005 Sie 16,308 —
©2 Microsoft Office Live Commurications Server 2005 Resource Kit Sze  B.04ME
©2 Microsoft Office Live Commurications Server 2005, Archiving Ske  10.44ME
Service:
&) Microsoft SQL Server 2000 Siee  93.54MB
3] Microsoft SQL Server Desktop Engine (IMSECUIRITY) Sze  69.07MB
5! Netscape (7.2)
B Remcte Admiristrator v2.0 Sz 1LSIME
151 RTC Client AF1 v1.2 Size 4,095.00MB
O Soundhais: Sze  12.4BMB
5! Trend Micro IM Security For Microsoft Live Communications Server Size  85.61MB
{3 Trend Micro Officecan Cient Size  67.19MB
B windaws Messenger 5.1 Size 4,088.00MB
5! windaws Server 2003 Service Pack 1
&g WM Tools Site 4.52MB |

TABLE 4-1. System changes after installing IM Security
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Services

Setup adds the following services:

4-6

SERVICE

DESCRIPTION

Trend Micro IM Security
Server

The core IM Security service.

Trend Micro IM Security Server depends on Windows
Management Instrumentation (WMI),
MSSQL$IMSECURITY, and Trend Micro IM Security
System Attendant services. It is responsible for core IM
Security processes (management console access, saving
configuration, and invoking the scan, update, report, and
notification processes).

Trend Micro IM Security
System Attendant

Monitors the service status of Live Communications
Server and IM Security Server services.

The service depends on the WMI and
MSSQLS$IMSECURITY services.

MSSQLS$IMSECURITY

IM Security SQL server instance.

<root>:\Program
Files\IMSecurityDBEngineMSSQLSIMSECURITY\B
inn\sqglservr.exe -sIMSECURITY controls this
service.

SQLAgent$IMSECURITY

The IM Security SQL agent is used to perform scheduled
and maintenance tasks.

<root>:\Program
Files\IMSecurityDBEngineMSSQL$IMSECURITY\B
inn\sqglagent.EXE -i IMSECURITY controls this
service.

TABLE 4-2. IM Security services

Tip: Use the Windows Services Panel to check for the status of IM Security services.
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Processes
Setup adds the following processes:
PROCESS NAME DESCRIPTION
servIMSSA.exe The Trend Micro IM Security System Attendant Service
process.
servIMSHost.exe The IM Security main process.
TABLE 4-3. IM Security processes

Tip: Use Windows Task Manager to check whether these processes are running.

Program Folders

Setup adds the following program folders (if the default Setup settings are kept):

FOLDER NAME DESCRIPTION

c:\Program Files\Trend Micro\IM | IM Security program files/folder path.

Security
c:\Program Files\Trend Micro\IM | IM Security database file and transaction
Security\Database log folder path.
c:\Program Files\Microsoft SQL | The IM Security Microsoft Database Engine
Server\MSSQLSIMSECURITY (MSDE) 2000 program path.

TABLE 4-4. IM Security program folders
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Preparing Other Antivirus Applications

If you are running Trend Micro ServerProtect or other antivirus product on the IM
Security server, exclude the IM Security Quarantine, Backup and Temp directories
from scanning. Otherwise, a scanning conflict will occur.

If you are using ServerProtect, refer to the ServerProtect documentation for
instructions to exclude IM Security folders from scanning.

Verifying a Successful Installation

4-8

Trend Micro recommends using the European Institute for Computer Antivirus
Research (EICAR) test script as a safe way to confirm that IM Security virus
scanning is running and working properly.

WARNING! Depending on how you have configured your IM Security servers, you might
need to disable antivirus products for the duration of the EICAR test
(otherwise, the virus might be detected before it arrives at the IM Security
server). This leaves your servers vulnerable to infection. For this reason,
Trend Micro recommends that you only use the EICAR test in a test
environment or pilot deployment (see page 2-5).

Alternatively, go to
http://www.trendmicro.com/en/security/test/overview.htm
and download a copy of the industry standard EICAR test script to your hard drive.
The EICAR fileisatext filewith a * . com extension. It isinert. It isnot avirus, it
does not replicate, and it does not contain a payload. Never use rea viruses to test
your antivirus installation.

To test IM Security with EICAR:
1. If necessary, disable antivirus products that might detect the EICAR test file
before it arrives at your LCS server.

2. Openan ASCII text file and copy the following 68-character string to it.
X50 ! P%$@AP [4\PZX54 (P™) 7CC) 7 } SEICAR-STANDARD-ANTIVIRUS-TEST-FILE!
SH+H*

3. Savethefileaseicar test.comtoatemporary directory and then closeit.


http://www.trendmicro.com/en/security/test/overview.htm

Getting Started

4. Start Windows Messenger and send eicar_ test.com to oneof your contacts
(preferably to another network administrator or IT personnel).

5. Access the management console and query virus scan logs.
IM Security detectsEICAR aseicar_ virus, quarantines
eicar_test.com, logsthe event, and sends notifications to sender and
recipient.

Alternatively, check the M notification senttotheeicar test.comrecipient and

to your account.

#2 IMs_TITANCENTER@titanlcs.com - Conversatio =]

File Edit Yiew Actions Help

To:

IMS_TITANCENTER®@titanlcs.com

R Mever give out your password or credit [«
card nurmber in an instant message
Cornwersation,

Invite Someone ta
this Conversation

1 Send a File or Photo

Start Application
Sharing

@ Start Whiteboard

IMS_TITAMCEMTER @titanlcs.com says:
The file ("eicar_test.com") that you
are trying to send matches the
organization's antivirus settings. IM
Security detected "eicar_virus" in
"eicar_test.com" and took the
"Quarantineg" action.

@ Elock A Fort %% ~Ematicans

FIGURE 4-8. Sample IM-based notifications sent by
the IM Security notification account

Note:  Virus scanning enables IM-based notifications to sender and recipient by default.
See page 4-13 for details about IM Security default settings.

IM Security opens anew Conver sation window when sending notifications coming
from the IM Security notification account. In the sample notification above (Figure
4-8), IMS_TITANCENTER isthe notification account (see page 3-19).
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Accessing the IM Security Management
Console
Use one of the following methods to access the management console:

* Localy onthe IM Security server (see page 4-10)
* Remotely viaHTTPS or HTTP (see page 4-11)

Tip: During installation, decide whether to enable the SSL protocol to enable
HTTPS transmission.

Accessing the Management Console Locally

If you have local access to the IM Security server, configure IM Security settings by
opening the management console locally.

To access the management console locally from the IM Security server:

1. Click Start > All Programs > Trend Micro IM Security for Microsoft Live
Communications Server > |M Security Management Console. A browser
opens and displays the L ogon page.

TREND MICRO™IM Security for Micrassft Live Communications Server 13 menn

TREND MICRO
IM Security

for Microsoft Live Communications Server

Please type your User name and Password to access the management console.

User nama: |

Password: I ‘:fe,,..,, >

Copyright @ 1338-2004 Trend Micro Incorporated. All rights reserved, |

FIGURE 4-9. Management console Logon page

Tip: Ensure that you are using a compatible browser. Otherwise, the management
console page will not be accessible. See page 2-6 for browser requirements
or page 5-4 for troubleshooting management console access issues.
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2. Typethe user nameand password in thefield provided.

Tip: The user name and password correspond to the Administrator Account you
set up during IM Security installation (see page 3-18).
3. Click (==
The Summary page displays.

You can only access one instance of the management console from one computer.

Accessing the Management Console Remotely

Setup enables secure sockets layer (SSL) management console connection when the
Enable SSL option is selected during installation. ThisallowsIM Security to encrypt
the configuration data as it passes from the IM Security management console to the
IM Security server. Alter the management console URL to use the HTTPS protocol
through port 443.

To access the management console remotely:

1. Typeone of the following addressesin your browser's Address field to open the
Log on page:

https://<host names>:<port>/IMSecurity

Where:

* <host name> iSthelM Security server's fully qualified domain name
(FQDN), IP address, or server name

* <ports> istheport to be used during an HTTPS session (for example,
443)

When accessing a secured IM Security site, it automatically sendsits

certificate, and Internet Explorer displays alock icon ( & ) on the status bar.

http://<host name>/IMSecurity

Where <host name> isthe IM Security server'sfully qualified domain name

(FQDN), IP address, or server name. If the HTTP port is modified to another

value other than the default port number (80), including the port number in
the URL is necessary.

See Table 4-5 for differences between HTTPS and HTTP access.
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2. TypetheIM Security administrator account’s user name and password in the
fields provided.

3. Click

The management console index page, Summary, displays.

Enter

The following table lists the differences between HTTPS and HT TP access:

CAPABILITIES HTTPS HTTP
Secure transmission v n
Plain text transmission u v
Viewable registered servers v v
(Server Management)

TABLE 4-5. Differences between HTTPS and HTTP access
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Checking Default Settings

Table 4-6 enumerates the default settings implemented in a successful IM Security

installation.

PAGE

DEFAULT VALUE

Virus Scanning

Enable virus scanning: Enabled

Target: All scannable files

Action: ActiveAction

Notification: Sender and Recipient (IM only)

File Blocking

Enable file blocking: Disabled
Default rules: Disabled

File Transfer Scan >
Content Filtering

Enable content filtering: Disabled
Default rules: Disabled

Instant Message Scan
> Content Filtering

Enable content filtering: Disabled
Enable trust scan: Disabled
Default rules: Disabled

Manual Update

Components: All components selected

Scheduled Update

Enable scheduled update: Enabled

Components selected: Default and additional threat
patterns

Schedule: Daily at 2:30AM

Update Source

Source: Trend Micro's ActiveUpdate Server

Alerts

IM Security conditions enabled:
Services started unsuccessfully
Services stopped

Component update is unsuccessful

Live Communications Server conditions enabled:
Services stopped

Recipients: Write to Windows Event log

One-time and
Scheduled Reports

Empty

Log Maintenance

Manual: All logs, Delete logs older than 30 days
Scheduled: Enabled (same setting as manual)

TABLE 4-6.

IM Security default settings
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PAGE DEFAULT VALUE

Folders

Quarantine Folder (Virus Scanning):
<Installation paths>\quarantine\

Backup Folder (Virus Scanning):
<Installation paths\backup\

Archive Folder (File Blocking):
<Installation paths\archive\

Archive Folder (File Transfer Content Filtering):
<Installation paths\archive\

Debug Logs Disabled

TABLE 4-6. IM Security default settings

WARNING! Clicking Reset from any of the management console pages instructs IM

Security to restore the default settings for a specific page. If there are
customizations or additional rules that you have created after installing IM
Security, those settings/rules will be removed after clicking Reset and
confirming the action.
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Updating Components

Complete the following task before updating IM Security components:

»  Configure proxy server settings (optional)
Depending on how you configured your Proxy Server during installation, you
may skip this step.

e Set the update source (optional)
Use the default update source-ActiveUpdate.

»  Update components manually

Tip: Set scheduled update to ensure automatic component updates. This help ensure the
currency of your antivirus and unwanted content protection.

Configuring Proxy Server Settings

If your system uses a proxy server to accessthe Internet, use the Proxy Settings page
to set proxy server settings for the following IM Security features:

» ActiveUpdate or other Update Source

*  Product Registration

*  World Virus Tracking

To configure the proxy server settings:

1. Accessthe management console (see page 4-10).

2. Click Administration > Proxy on the navigation menu.

3. Onthe Proxy page, select Use a proxy server for component download and
product activation.

4. Under Proxy Server, configure the following:

»  Typethe server name or | P address of the proxy server and its port
number

* Click Use SOCK S5 if SOCK S5 protocol is used

5. Under Proxy Authentication, type the user name and password used to access
the proxy server.

6. Click Saveto apply settings.

Ensure the correctness of the proxy server settings. Otherwise, component update or
product registration might not work.
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Setting the Update Source

Set the update source to define the location where IM Security downloads the latest
antivirus and content security component. The source specified in the Update
Sour ce page applies to both manua and scheduled updates.

4-16

Here are some common scenarios why the update source needs to be changed:

Downloading a special build of the pattern file or scan engine from a different
source

During product troubleshooting (that is, when being instructed to do so by a
technical support engineer)

Using an alternative update server on your intranet to avoid multiple connections
to the Internet

To set the update source:

1. Accessthe management console (see page 4-10).
2. Click Updates> Source on the navigation menu. The Update Sour ce page

appears.

12 TREND MICRO™IM Security far mormsoft Live Gommunications server L3 OF |

Current servar; TW-SMEX-SYR1 Server Mansgement

Update Source @
Summary
* File Transfer Scan Update Source
b Instant Message Scan @ Trend Micra's Activelpdate Server
~ Updates " Intranet location containing a copy of the current file
Manual UNC path: I
Scheduled For example: Yitu-serverdownload
Cource User name:
..... e paceword: T
b Reports " Other update source
b Logs [reteesy
» acinizration Farssamala: el sener st e dte e
[T Duplicate the update package onto this server

Save | Reset

FIGURE 4-10. Update Source page

If necessary, select the location from which IM Security receives updates. The
default location isthe Trend Micro ActiveUpdate server.

Tip: To ensure the latest component version, retain the default setting.
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4,

5.

If the IM Security server corresponding to this instance of the management
console is the update source for other IM Security servers, select Duplicate the
update package onto this server. Thisoption instructs IM Security to download
the update package (pattern file and scan engine) to the IM Security server. You
can then set the current server as the update source for other servers.

Click Saveto apply settings.

When you invoke a manual or scheduled update, IM Security will download the
component from the set source.

Updating Components Manually

To help ensure up-to-date protection, update the default scanning pattern,

spyware/grayware pattern, and scan engine immediately after installing IM Security
or during virus outbreaks.

To update components manually:

1. Accessthe management console (see page 4-10).

2.
appears.

Click Updates > M anual on the navigation menu. The Manual Update page

t—

TREND MICRO™IM Security for Microsoft Live Communications Server 29 OF

Surmmary
b File Transfer Scan
¥ Instant Message Scan
~ Updates

_Manual

Bource
P —
¥ Reports
¥ Logs

+ Administration

Current server: TW-SMEX-SYR1 Server Managernent

Manual Update

schedu\ed

Components

#dditional thraats pattern

&
I~
¥ Defsult scanning pattern
172
I

Scan engine

Current
Wersion

2.520.00
0.240.00

7.510.1002

Available
nia
nia

nfa

Status
nia
nia

nia

FIGURE 4-11. Manual Update page

3. Select the antivirus and content security components that IM Security will

download.
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Tip: Trend Micro recommends checking for the latest version of the default
scanning pattern, spyware/grayware pattern, and scan engine components.

4. Click Update to invoke manual update.

Clicking Update instructs IM Security to read the Manual Update page settings,
check for, and download the latest components from the update source.
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Chapter 5

Troubleshooting and FAQ

This chapter describes how to troubleshoot issues that may arise with IM Security.

The topics discussed in this chapter include:

Installation on page 5-2

Product Registration and Activation on page 5-3
Management Console Access | ssues on page 5-4
Frequently Asked Questions on page 5-7
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Installation

One of the following issues may occur during IM Security:

*  Setup stops responding

e Setup reports a successful installation, but IM Security services are not started
*  Setup stops because the minimum system requirements are not met

To troubleshoot IM Security installation issues:

1. Check the Setup debug log (c: \IMSecurity Install.log) for possible
€rror messages.

Note:  Trend Micro Technical Support providers use the debug log to understand
installation issues.

2. Verify and ensure that a user with Domain Admins privilegesislogged on to the
server where IM Security should be installed.
z2ix

General Members | MamheerI Managed Byl

Members:

Mame | Active Directory Folder
ﬂ Adrninistratar hig-tu-win2003. comdUsers
IM Security Administrator — hie- Alsers
ﬂ LCService hig-tu-win2003. comdUsers
K| | 2l

Add... Remove
oK I Cancel | Apply |

FIGURE 5-1. Use an account with Domain Admin privileges when
installing IM Security

3. Revisit and ensure that none of the conditions described under Deployment
Considerations has been violated.

4. Verify whether the system requirements have been met (see page 2-6).

If the above steps do not work, contact your Trend Micro support provider (see page
6-2).
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Product Registration and Activation

One of the following issues may occur that |eads to unsuccessful registration and/or
activation:

Product registration is successful, however, no Activation Code (AC) was
received from Trend Micro

Unableto activate IM Security during installation or through the management
console

To troubleshoot product activation issues:

1.

Register IM Security to obtain an AC (see page 3-2).

Note: Do not use the Registration Key (RK) when activating IM Security.
Otherwise, product activation will not work. A Registration Key is used to
register a product to the Trend Micro Online Registration
(http://olr.trendmicro.com). Alternatively, an Activation
Code is used to activate a product’s features during or right after
installation.

Verify the AC used. Be sure to use the following format when specifying the AC:

XX -XXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX

If there are messages or logs related to product activation, check for the possible
solutions offered by the logs or messages.

Tip: Refer to the Online Help > View Summaries, Logs, and Reports section for
instructions to query logs.

Ensure the number of L CS clients does not exceed the number of seats for which
the license isvalid. Otherwise, product activation will not work.

Tip: The Product License > Seat status field displays the number of seats
available and used. Refer to the Online Help > Administer Servers section for
instructions to view product license information.

If the above steps do not work, contact your Trend Micro support provider (see page
6-2).
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Management Console Access Issues

One of the following issues may occur when trying to access the IM Security
management console:

» Inaccessible management console
*  Missing User name and Password field
»  Unrecognized User name and Password

To troubleshoot management console access issues:

1. Ensurethelatest Microsoft or Sun Java Virtual Machine (VM) isinstalled on the
IM Security server (see page 2-6). Otherwise, the User name and Password
field will not appear on the management console.

Note:  IM Security supports Microsoft VM and Sun JVM version 1.4.1_02. For
more information about Microsoft VM, please visit
http://www.microsoft.com/mscorp/java/.

TREND MICRO
IM Security

for Microsoft Live Communications Server

Please type your User name and Password to access the management console.

]

Copyright @ 1998-2005 Trznd Micro Incarporatzd, All rights reserved,

FIGURE 5-2. Missing User name and Password field— install the latest
Microsoft or Sun JVM
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2. Usethe Windows Services panel to verify whether Trend Micro IM Security
Host Serviceis started.

File  Action Wew Help
o | BERB(E2[r n 0w
@Sarvices (Local) #, Services (Local)

Trend Micro IM Security Server Name 7 I Status Iﬂ
Telnet

Stop the service %Terminal Services Started

Bestart the service %Termlnal Services Session Directory

%Themes

Description:
Provides IM Security core processes,

Er
y System Attendant Started
%Uninterruptible Power Supply [
%Upload Manager

%Virtua\ Disk Service hd
4] | »
Extended A Standard /

FIGURE 5-3. Inaccessible management console— ensure IM Security
Host Service is started

3. Verify the Web service (11S or Apache) is started.

4. Verify whether the IM Security administrator account has not been changed.
Otherwise, obtain the latest user name and password of the administrator
account.

5. Check the network connection, and verify the ports needed by the management
console are accessible (see page 2-7).
6. Check whether the following settings are true:

*  Both IM Security and Microsoft SharePoint™ Portal Server areinstalled on
the same server

e ThelM Security management console belongs to the Microsoft I nternet
Information Services (11S) Default Web site

If dl of the above conditions are true, the management console will be

inaccessible. SharePoint prevents access to other Web sites by default. To

exclude the IM Security Web site, add | M Security in the Excluded path of

Sharepoint Central Administration virtual server settings. Refer to the Online

Help > Troubleshooting section for detailed instructions.

If the above steps do not work, contact your Trend Micro support provider (see page
6-2).
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Component Update Issues

If you configured the update source to download antivirus and content security
components from Trend Micro ActiveUpdate, and the latest components cannot be
downloaded, check the connection from the IM Security server to the ActiveUpdate
server.

To troubleshoot ActiveUpdate issues:
1. Check whether the IM Security server is connected to your network.
In addition, verify your network connection and server status.

2. Runthefollowing commandsto make surethe IM Security server can resolvethe
ActiveUpdate server’s FQDN (see Figure 5-4).

nslookup

i testdns.trendnet.org
10.1.107.48

curity-p.activeupdate.trendmicro.-con
internaldns .trend.com. tw
10.1.187.48

speedera.net
3. 3, 288._185.219.189
ecurity—p.activeupdate .trendmicro.con

>
IC:~\>ping imsecurity-p.activeupdate.trendnicro.com

Pinging ssl.trendmicro.speedera.net [211.13.215.1331 with 32 hytes of data:

Reply from 211.13.215.133: hyt
Reply from 211.13.215.133: byt
Reply from 211.13.215.133: byt

Ping s for 211.13.215.133:

Pa nt = 4. Received = 3, Lost = 1 (26x loss),
Approxinate round trip times in milli-seconds:

Minimum = 47ms, Maximum = 94ms. Average =

C:N>

FIGURE 5-4. Use ping and nslookup to test connection between IM
Security and ActiveUpdate servers

3. Usetelnet to connect to the ActiveUpdate server at port 80 to make sure the
IM Security server can connect viaHTTP.

If the above steps do not work, contact your Trend Micro support provider (see page
6-2).
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Frequently Asked Questions

This section answers the following common questions about IM Security:
»  General Product Knowledge
» Installation, Registration, and Activation

General Product Knowledge
WhatisIM Security?
e How does IM Security protect my LCS server?

* CanIM Security scan files or filter messages transmitted using non-LCS IM
chats via M SN/Windows M essenger?

e CanIM Security filter content of all file types?
*  What are the instant messaging applicationsthat IM Security supports?
*  What are the instant messaging clients that IM Security supports?

Installation, Registration, and Activation

e Can| specify another agent notification account sometime after the IM Security
installation?

*  Wherecan| get aRegistration Key or Activation Code?

Please refer to the IM Security Online Help > Frequently Asked Questions topic for
more answers to management related questions.

What is IM Security?

Trend Micro™ IM Security is an application that provides antivirus and
content security protection to Microsoft Live Communications Server
environments.

How does IM Security protect my LCS server?

IM Security provides rea-time virus, spyware, and other grayware
scanning, file blocking, and content filtering. Refer to the Online Help >
Protect IM Environments section for details.
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Can IM Security scan files or filter messages transmitted via
non-LCS IM chats via MSN/Windows Messenger?

IM Security can only scan files or filter messages transmitted via Microsoft Live
Communications Server.

Can IM Security filter content of all file types?

No. IM Security isableto filter content of Microsoft Office files (* . ppt,
* . doc, *.x1s) and Adobe portable document formats (* . pdf).

What are the instant messaging applications that IM Security
supports?

As of thisrelease, IM Security protects servers where Microsoft Live
Communications Server isinstalled.

What are the instant messaging clients that IM Security supports?

IM Security supports the following messaging clients:
*  Windows Messenger 5.0
*  Windows Messenger 5.1

Where can | get a Registration Key or Activation Code?

Refer to the Trend Micro Web site
(http://kb.trendmicro.com/solutions/search/main/sea
rch/solutionDetail.asp?solutionId=16326) for details.

Can | specify another agent notification account sometime after the
IM Security installation?

IM Security only alows a single agent notification account. You may specify a
new account by using the Agent Account Tool.
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Chapter 6

Getting Support

Trend Micro is committed to providing service and support that exceeds our user’s
expectations. This chapter contains information on how to get technical support.
Remember, you must register your product to be eligible for support.

This chapter includes the following topics:

Contacting Technical Support on page 6-2
Sending Infected File Samples on page 6-3
Reporting False Positives on page 6-3
Introducing TrendLabs on page 6-3

Other Useful Resources on page 6-4
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Contacting Technical Support

Before contacting technical support, here are two things you can quickly do to try and
find a solution to your questions:

6-2

Check your documentation: the Troubleshooting and FAQ section of this
Getting Sarted Guide and Online Help provide comprehensive information
about IM Security

Search both documents to see if they contain your solution.

Visit our Technical Support Web site: our Technical Support Web site contains
the latest information about all Trend Micro products

The support Web site has answers to previous user inquiries. To search the
Knowledge Base, visit

http://kb.trendmicro.com

In addition to phone support, Trend Micro provides the following resources:

Email support
support@trendmicro.com

Readme: |ate-breaking product news, installation instructions, known issues, and
version specific information

Product updates and patches

http://www. trendmicro.com/download/

To locate the Trend Micro office nearest you, open a Web browser to the following
URL:

http://www. trendmicro.com/en/about/contact/overview. htm

To speed up the issue resolution, when you contact our staff please provide as much
of the following information as you can:

IM Security Activation Code

Version

Exact text of the error message, if any
Steps to reproduce the problem
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Sending Infected File Samples

You can send viruses, infected files, Trojan programs, spyware, and other grayware
to Trend Micro. More specificaly, if you have afile that you think is some kind of
threat but the scan engine is not detecting it or cleaning it, you can submit the
suspicious file to Trend Micro using the following Web address:
subwiz.trendmicro.com

Please include in the message text a brief description of the symptoms you are
experiencing. Our team of virus engineers will "dissect” the file to identify and
characterize any viruses it may contain.

Reporting False Positives

Report false positive detections to false@support . trendmicro. com.

Trend Micro Technical Support replies to your message within twenty-four (24)
hours.

Introducing TrendLabs

Trend Micro TrendLabs®™ is a global network of antivirus research and product
support centers that provide continuous 24 x 7 coverage to Trend Micro customers
around the world.

Staffed by ateam of more than 250 engineers and skilled support personnel, the
TrendL abs dedicated service centersin Paris, Munich, Manila, Taipei, Tokyo, and
Irvine, CA. ensure arapid response to any virus outbreak or urgent customer support
issue, anywhere in the world.

For more information about TrendL abs, please visit:

www . trendmicro.com/en/security/trendlabs/overview.htm
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Other Useful Resources

6-4

Trend Micro offers ahost of servicesthrough its Web site,
www . trendmicro.com.

Internet-based tools and servicesinclude:

*  Virus Map: monitors virus incidents around the world
*  HouseCall™: Trend Micro online virus scanner

*  Virusrisk assessment: the Trend Micro online virus protection assessment
program for corporate networks
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Glossary

Tip: For faster glossary search when
viewing this appendix online, use the
Acrobat Reader’s Find option to
search for aterm.

A B C D E F G H |

J K L M N OUP QR

S T UV WX Y Z

Alerts

Refer to messages that include IM Security ser-
vice, update status, or Live Communications
Slerver events. Use the Alerts page to configure
alerts.

Blocking rules
See file blocking rules.

Content filtering rules

In IM Security, content filtering rules refer to
rules that instruct IM Security how to filter mes-
sages and files for unwanted content.

E Top

Events
Refer to IM Security or Live Communications
Server actions that trigger or instruct IM Security

to send alerts or notifications.

F Top

False positives

Occurs when a valid Web site, URL, message,
or file is incorrectly determined by software to be
of an unwanted type.

File blocking rules

Short for file transfer blocking rules. File blocking
rules are rules that instruct IM Security to block
unwanted or infected files from being transferred
from one contact to another.

File content filtering rules

Short for file transfer content filtering rules. File
content filtering rules are rules that instruct IM
Security to apply the set action for files with
unwanted content.

L Top

LHA
Compressed file archive created by
LHA/LHARC (Iha255h.exe).

Logs
A time-sequential record of IM Security events.

N Top

NMS

In the SNMP management architecture, one or
more computers on the network acts as a net-
work management station (NMS) and polls the
managed devices to gather information about
their performance and status.

Notifications

Refer to messages generated by IM Security
about virus scanning, file blocking, and content
filtering events.

P Top
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Pattern file

Pattern file is a Trend Micro component that pro-
vides rules and signatures to detect viruses,
spyware, and other grayware. IM Security uses
the scan engine, virus pattern, and spy-
ware/grayware pattern to detect known viruses,
spyware, and other grayware.

Reports

A collection of logs about virus and content
security events that occur in an IM Security net-
work. Generate reports to consolidate logs in an
organized and graphically appealing format.

Scan engine

The antivirus component that identifies viruses,
spyware, and other grayware present in files
transferred in a Live Communications Server
environment.

SNMP

Simple Network Management Protocol (SNMP)

is a set of communication specifications for man-
aging network devices, such as bridges, routers,
and hubs over a TCP/IP network.

SOCKS5

The SOCKSS5 protocol, also known as authenti-
cated firewall traversal (AFT), is an open Inter-
net standard (rfc1928) for network proxies at the
transport layer.

Traps

Notifications sent by managed devices to the
NMS when certain events occur, such as a shut-
down or authentication error.

W Top

Windows event log

The Alerts > Recipients screen allows you to
enable Windows event logging. When enabled,
view logs through the Windows Event Viewer
screen.

Worms

A self-contained program (or set of programs)
thatis able to spread functional copies of itself or
its segments to other computer systems, often
via email.



IM Security Deployment Checklists

Use the following checklists to record relevant system information:
* Installation Checklist on page B-2

»  Ports Checklist on page B-3

*  Pre-installation Tasks Checklist on page B-4

They will be needed from time to time.
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Installation Checklist

The following server address information is required during installation, and for
configuring the IM Security server to work with your network. Record them here for

easy reference.

INFORMATION REQUIRED

SAMPLE

YOUR VALUE

IM SECURITY SERVER INFORMATION

Registration Key (RK) and RK:
Activation Code (AC) AC:

IP address 10.1.104.255
Administrator account IMS_admin

Agent notification account

IMS_noatification

WEB SERVER INFORMATION

IP address 10.1.104.225

Fully Qualified Domain Name (FQDN) | server.company.com
NetBIOS (host) name yourserver

Uses SOCKS5 No

PROXY SERVER INFORMATION

IP address 10.1.174.225
Fully Qualified Domain Name (FQDN) | proxy.company.com
NetBIOS (host) name proxyserver

SMTP SERVER INFORMATION

IP address

10.1.123.225

Fully Qualified Domain Name (FQDN)

mail.company.com

NetBIOS (host) name

mailserver

SNMP TRAP INFORMATION

Community name

trendmicro

IP address

10.1.194.225
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Ports Checklist

IM Security uses the following ports for the indicated purposes.

SERVICE SAMPLE PORT VALUE YOUR VALUE
Management Console and 80
Update/Deploy components
File transfer 6891-6900
SMTP 25
SNMP 162
Server Management population 3268
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Pre-installation Tasks Checklist
Beforeinstalling IM Security, complete the following tasks:

COMPLETED? PRE-INSTALLATION TASKS

] If a firewall exists between an LCS server and its clients, open the ports described
in Table 2-2 to ensure IM Security connectivity.

Log on to the target server using an account with Domain Admins privilege.

Disable or uninstall other IM environment antivirus applications.

Check the target server’s compliancy to the system requirements.

Obtain the proxy server and SMTP server settings and authentication information
(if necessary).

Close opened Microsoft Management Console (MMC) screens.

Prepare the IM Security Activation Code (see page 3-2).

O, 0|0|0|0)|0
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updating manually 4-17
user interface. See management console
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VirusMap 6-4

virus protections 1-12
virus risk assessment 6-4
virus scanning 1-5
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resetting 4-14
testing EICAR 4-8
testing installation 4-8
verifying install ation 4-8
Web server 2-7
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